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About this course
Objectives of the course
Upon completion of this course you will be able to:
- Become familiar with the Knowledgeware working environment, how it 
can be accessed, the terminology that will be used and the Settings.
- Create a parametric part.
- Embed design knowledge in the part by creating rules, checks and 
reactions.
- Automate your designs modifications using various Knowledgeware
Advisor tools.

Targeted audience
CATIA V5 Designers

Prerequisites
Students attending this course should have knowledge of CATIA V5 Basics

8 hours
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Knowledge Advisor Workbench Presentation
You will learn what are the main features of the Knowledge Advisor workbench as well 
as some infrastructure features provided with CATIA V5.

Accessing the Workbench
User Interface
Knowledge User Settings
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Accessing the Workbench

You can access the Knowledge Advisor workbench through the usual ways:

A From the Start Menu

B From the workbench icon: 

C From a CATIA document

Go to Tools /Customize /Start Menu to 
customize the content of this Welcome box

If the Relations node exists in the specification tree, 
double-click on it to launch the Knowledge Advisor 
workbench.

x2
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User Interface (1/4)

Common Knowledge Toolbar allows you to access:
Formulas, Comments and URLs, Check Analysis, Design Table creation, Law creation, 
Knowledge Inspector, Lock/Unlock parameters, and Equivalent Dimensions

Knowledge 
Advisor 
Workbench

Parameters node
contains User 
Parameters and 
Lists

Relations node
contains: 

- Formulas

- Rules

- Checks

- Design Tables
- Reactions

and Macro with 
arguments
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User Interface (2/4)

Searches for the URLs assigned to the user parameters or the relationsComment and URLs

Enables the user to apply the same value to selected Angle or Length 
parametersEquivalentDimensions

Locks or unlocks the selected parametersLock selected 
parameters

Allows to evaluate the impact of modifications (what if), and how to modify 
the parametersKnowledge Inspector

y=f(x) mathematical law that can be used by geometric or analysis 
operatorsLaw

Tabulated relation of a set of parameters based on an Excel spreadsheet or 
a text fileDesign Table

Simple formulas y=f(x,y,z,…) between any V5 parametersFormula

DefinitionNameIcon
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User Interface (3/4)

Creates a node of RelationsAdd Set of Relations

Creates a node of ParametersAdd Set of parameters

Loop similar to the loop in the languages that manage the creation, 
destruction or modification of a set of features. The loop is superseded by 
the powerful ‘Knowledge Pattern’ function of the Product Knowledge 
Template Workbench.

Loop

List referencing a set of objects (parameters or geometric features). May 
compute list size, sum, min, max, etc…List

Feature embedded in the design that reacts to specific events, and 
propagates any kind of modificationsReaction

DefinitionNameIcon

Check embedded in the design that reacts to parameter changes, and 
informs the user in case of violationCheck

Rule embedded in the design that reacts to parameter changes, and 
propagates parameter or geometric modificationsRule
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User Interface (4/4)

Mathematical set of equations and inequations that drives a set of output 
parameters, according to the changes in the input parametersSet of Equations

Updates relations using measuresMeasure Update

Feature that describes a function that a user can decide to executeAction

DefinitionNameIcon

Feature to run VBScript macros with arguments. Can be called from a Rule 
or a ReactionMacros with arguments

Adds URLs on user parameters or relations and searches for the existing 
URLsComment and URLs

Adds parameters to an edge, a face or a vertex Add parameters on 
geometry

Creates the user parameters stored at the feature levelParameters Explorer
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Knowledge User Settings (1/5)

Check the corresponding option if you need:

(1) The value of the parameter to appear in the tree.

(2) The formula driving the parameter to appear in the tree beside the parameter.

(3) To work with non-latin characters. Otherwise, the parameters have to be renamed in latin
characters when used.

(4) To create synchronous relations; relations that will be immediately updated if one of their 
parameters is modified. Relations based on the parameters are the only ones that can be 
synchronous.

(5) To associate the evaluations of asynchronous relations with the global update. The relations can 
be asynchronous for two reasons: when the user wants the relations to be asynchronous or when 
the relation contains measures.

1

2

3

4

5

Display and update General Settings:
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Knowledge User Settings (2/5)

(1) Automatic Synchronization At Load: While 
loading a model containing the user design 
tables, if the design table files have been 
modified, and if the external file data is contained 
in the model, the design table will be 
synchronized automatically if this button is 
checked.

(2) Interactive Synchronization At Load: While 
loading a model containing the user design tables 
whose external source file was deleted, this 
option enables the user to select a new source file 
or to save the data contained in the design tables 
in a new file. 

(3) Manual Synchronization: While loading a model 
containing the user design tables, if the design 
table files have been modified and the external file 
data is contained in the model, the design table 
will be synchronized if this radio button is 
checked. To synchronize both the files, right-click 
the design table in the specification tree and 
select the DesignTable object->Synchronize 
command or the Edit->Links command. 

(4) Default Mode: Copy Data Into Model: If checked, 
the data contained in the external source file will 
be copied into the model.

(5) Default Mode: Do Not Copy Data Into Model: If 
checked, the data contained in the external 
source file will not be copied into the model.

3

5

4

2

1

Design Tables General Settings:
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Knowledge User Settings (3/5)

(1) Check this option to have access to more language libraries. That means more functions will 
be available for the Edition of Relations.

(2) Check this button to load ALL the available libraries.

(3) Otherwise, select the libraries packages in the list and use the arrows to add or retrieve them 
to the list of libraries to be loaded.

2

1

3

Language Settings:
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Knowledge User Settings (4/5)

Check the corresponding options if you need :

(1) The parameters of the part to be displayed in the specification tree.

(2) The relations of the part to be displayed in the specification tree.

1

2

Part Infrastructure Settings:
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Knowledge User Settings (5/5)

Activate the following options if you need :

(1) The parameters of the product to appear in the specification tree.

(2) The relations of the product to appear in the specification tree.

2

1

Product Structure Settings:
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Stringer
Master Exercise Presentation

65 min

In this exercise, you will practice:

Creating User Parameters
Creating Formulas
Creating geometry using User Parameters
Creating Rules and Checks for the design
Creating a Design Table and changing configurations 
using the design table

In this exercise, you will design the Stringer part and 
control its modification using the Knowledgeware 
tools.
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Creating Parameters, Formulas and Lists

Creating User Parameters
Creating and Using Formulas
Creating Lists
Associating URLs to Parameters and Relations
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Creating User Parameters
You will learn how to create and manage parameters.
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What are Parameters? (1/2)

Intrinsic 
parameters

Parameters
at Part level

Parameters at
Assembly level

There are many types of parameters:
Real, Integer, String, Boolean, Length, Mass...
Two kinds of parameters: 

Intrinsic Parameters are generated while 
creating any geometry and features. They 
define the intrinsic properties of the 
features (depth, offset, activity, …)
User Parameters are especially created by 
the user. They define the extra pieces of 
information added to a document. The User 
Parameters can be defined at different 
levels:
� Part level
� Assembly level 
� Feature level

User Parameters can either be defined:
With a single value (continuous). In this 
case, the parameter can take any value.  
Or with multiple values (discrete). In this 
case, the parameter can take only the pre-
defined values given at its creation.

Any parameter can be:
Defined or constrained by relations
Used as argument of relations
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What are Parameters? (2/2)

Length Type

User Parameters defined 
on a CATProduct

Parameters defined 
on a CATPart

String Type

Parameters in a product

Real Type



Instructor Notes:

Knowledge Advisor

Copyright DASSAULT SYSTEMES 21

����������	
����

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
YS

TE
M

E
S

Why Use User Parameters?

To have an immediate access to the parameters that pilot the geometry and to change 
easily their value.
To centralize key information so that any new user on the model can use it immediately.
To refer easily to the same parameter when editing relations.
With User Parameters, you can create generic models that are driven only from the User 
Parameter node.

All the key information of the model is 
accessible from this place of the part, so that 
you do not need to search in the PartBody to 
change the number of spokes, for instance.

Edition of 
the User 

Parameter
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Creating User Parameters (1/2)

1 Click on the f(x) icon.
The Formulas panel is displayed.

3 Click the New Parameter of type 
button to create the parameter.

2
Select the desired type of 
parameter and then specify the 
Single Value or the  Multi Values 
option.

The Multiple Values option allows you to pre-define 
fixed values for the parameter.

In this case, you are required to enter the values of 
the parameter as soon as you click the New 
Parameter of type button. The “Value List” panel 
appears. 

Type here the different 
values of the parameter. 
Click the Enter button to 
validate each value.

Use these arrows to 
reorder the values.

Click OK when finished.
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Creating User Parameters (2/2)

4
The new parameter appears at 
the end of the parameters list 
with a default name (here 
Real.1) and a default value 0.

5 You can rename the parameter 
by typing a new name in the 
Edit name field; and attribute it 
a value by filling the Edit value 
field.

6
The OK button validates the creation of the parameter and 
closes the Formulas panel.
The new User Parameter is added to the specification tree.
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The Formulas panel as well as many Editor panels, in which you may use the 
parameters, allow you to filter parameters in order to ease their selection.

Filtering Parameters (1/2)

1 When the selection panel is opened, first select your selection 
mode: incremental or not.

Then select in the specification tree the feature that contains 
the parameters that you want to use.2

With the incremental mode unchecked, 
ALL the parameters of the Groove and ALL 
those of its definition sketch are displayed.

With the incremental mode checked, the 
parameters of the Groove and ONLY the 
dimension parameters of its definition 
sketch are displayed.

lots of parameters are displayed: activities, modes, etc.

fewer parameters are displayed: only 7 where found for 
Groove.3
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Filtering Parameters (2/2)

If you still have too many parameters listed, you can use filters: you usually have the 
possibility to filter the parameters by types and by name.3

Types available in the “Filter Type” list are the 
types of parameters found in the current selection.

you can make a query per name

…or per type:

select a type in the list above

or…

You should now be able to select a parameter easily.4
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Adding Sets of Parameters

In the specification tree, you can create sets of parameters under the Parameters 
node in order to regroup the parameters by categories.

1
In the Knowledge Advisor workbench, click on Add 
Set of Parameters icon.

2
Select in the tree the Parameters node or an 
existing set of parameters under which the new Set 
of Parameters will be created.

4
You can reorder the already existing user 
parameters using the Reorder option of the 
parameter contextual menu. Select a Set of 
Parameters to place the parameter in it.

3 You can rename the Set of Parameters by editing its 
Properties (in the contextual menu).

5
To create a new user parameter directly in a 
specific Set of Parameters, you have to use the 
Parameter Explorer. Select a Set of Parameters 
before clicking the New Parameter of type button.

4

5
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The rim is replaced by a bigger one, the 
parameters of which are published under 
the same names than the first rim.The rim is replaced by a bigger one, 

the parameters of which are not 
published.

The number 
of holes of 

the hub and 
the diameter 

of the pattern 
automatically 

adapt to the 
new rim.

The external 
parameters of 
the hub are still 
linked to the 
first rim. They 
are not 
updated.

Why Publish Parameters?

In this example, the hub is linked to the rim: 
the hub reuses the number of holes and the 
pattern diameter of the rim. 
Let us see the difference in the behavior of 
the hub when replacing the rim, with its 
parameters published or not.

Publication of parameters is useful when replacing in an assembly a component which
contains parameters that drive other component’s external parameters. 
If the exported parameters are published and if the parameters of the replacing component are 
published under the same name, they will inherit the control of the exported parameters.
Otherwise, the parameters of the replaced component will keep the control.
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Publishing a Parameter (1/3)

Activate the part containing the 
parameter you want to publish.

1

3a

The Publication command is available in Assembly Design and Part Design. 
It publishes the geometry and the parameters as well.

Select Publication… in the Tools menu:
2

If the parameter you want to publish 
is a user parameter, click on its icon 
in the tree.

2x

The user parameter now 
appears in the list of published 
elements of the Publication 
dialog box.

4a
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Publishing a Parameter (2/3)

Select the parameter:
- directly in the dialog box
- or by the intermediate of 

the geometry 

4b

3b
If the parameter you want to publish is an 
intrinsic parameter, click the Parameter 
button of the dialog box.

Click OK to validate the selection.5b

The intrinsic parameter appears in the list of published 
parameters:6b
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Publishing a Parameter (3/3)

Published Parameters appear in the list with a default publication name. 7

8

9

10

Your newly published 
parameters appear 
under the 
publications node of 
the active part.

To modify the 
publication 
name, first 
select the 
publication.

Then, select the 
name field.

Edit the name 
and validate 
with Enter.

Validate the 
publication by 
clicking OK.

11 12
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Using Published Parameters (1/5)

Be activated on Guided_Part level and open the 
formula editor panel of Cylinder_InnerDiameter
parameter.

1

2

Published parameters are called while editing formulas.

In this example, we are going to make equal the inner cylinder diameter to the head 
diameter.

Edit the formula by selecting the Head_Radius 
parameter:

• Under the Publications’ node of Guiding_Part
• In the External Parameters of Guided_Part, provided 

that it has previously been copied with link. The 
copy with link is already made if you have used this 
external parameter before, or if you have 
intentionally copied/pasted it Special as result with 
link.

2

1
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Using Published Parameters (2/5)

3b

Published parameters are called while editing formulas.

3a

The External 
Parameters linked to 
the published 
parameters appear with 
a green Capital P on 
their icon in the tree.

The edited part has 
become contextual.
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Using Published Parameters (3/5)

The setting preventing 
the use of non published 
geometry also works with 
parameters.

1

2 When this option “Restrict External selection…” is activated, and when you select an unpublished 
parameter in an external document, no external parameter is created and no link is kept: only the value of 
the parameter will be taken (as if the option ‘Keep link…’ was deactivated).

In this case, the depth parameter of GuidingPart was not 
published and only its value (52mm) has been taken to 
edit this formula. Neither link nor external parameter are 
created.

Some CATIA options can prevent the user from creating external parameters from 
the unpublished parameters. 
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Using Published Parameters (4/5)

While using the published parameters you have to pay attention to the context 
assembly.

The first time you use an external reference 
or a published external parameter, not only 
you create links to external information, but 
you also define a “context” link from the 
edited part to the root assembly (by 
default). The context link is unique and the 
product it is connected to is called the 
context assembly.

If the root product is not anymore the context product of 
Guided_Part, its icon indicates it is out of context.

1

Knowledge link

Context link

2
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Using Published Parameters (5/5)

While using the published parameters you have to pay attention to the context 
assembly.

An external parameter which is 
created when the root product is not 
the context product will never be 
considered as connected to a 
published parameter.

In this new context, try to create, in the 
Guided_Part, a new formula referring to 
another published parameter of the 
Guiding_Part. 

3

4
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Creating and Using Formulas
You will learn how to create and use Formulas.
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What are Formulas?

Formulas are relations used to define or constrain any parameter. 
Formula can be defined with parameters, operators, and functions. 
A Formula is created from the moment you attribute a user parameter to a feature, for example.
The left part of the relation is the parameter to constrain and the right part is a statement.

Once it has been created, a Formula can be manipulated like any other feature from its 
contextual menu.
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Double-click on the 
parameter in the list or click 

the ‘Add Formula’ button

Creating a Formula (1/2)

1

You can create Formulas with ‘dimensions’ or User Parameters.

You can access the Formula Editor through different means:

- In the specification tree, double-click on the parameter or on the dimension you want to add a 
formula to. Right-click in the Value field and select ‘Edit formula’ in the contextual menu. 

or…

- Click on the f(x) icon; in the Formulas 
panel, use the filter to select the 
parameter you want to edit. Either 
double-click on this parameter or click 
the Add Formula button.

OR
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Creating a Formula (2/2)

The Formula Editor panel appears.
Enter the right side of the formula in the formula editor field.2

Check the Incremental mode button in order to display in the dictionary only the parameters of the 
feature selected in the specifications tree or in the 3D. If this option is not checked, will be displayed 
not only the parameters of the selected feature but also those of the features under it.

3 Click OK to validate the creation of the formula.
The Formula is added to the Relations node in the specification tree.

Enter the formula here

Use the dictionary to select a 
parameter or a function

Click to open the language browser panel (see specific slides). 

Click to attach a URL or a comment to the formula.

Click on the Eraser to delete all the contents of the formula field.
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While creating the parametric models you often have to select a parameter to use it 
in a statement, in a design table, or simply to edit it. Here are different ways of 
selection.

Selecting Parameters in the Formula Editor

If you are using the Parameters Dictionary, you can either double-click on 
it in the list or click once on it in the 3D.

If the parameter is displayed in the 3D (assembly constraint for instance) 
you can also click on it in the 3D.

If the parameter is displayed in the specification tree click on it.

If you know the exact name of the parameter you can also type it.

x2

A

B

C

D
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Using Measure Functions in Formulas (1/3)

When you are editing a formula, you have the possibility to use pre-defined functions, 
especially measures. The functions allow you to capture values from the geometry. 

To make sure that you have access to all these functions, check that the Load extended language 
libraries option is selected in the Knowledge tab of General settings (Tools>Options).

For instance, the functions of the Measures dictionary 
allow you to define a parameter as:

• A distance between two points
• The minimum radius of a curve
• The total length of a curve
• The length of a curve segment 
• The area of a surface or a sketch
• The perimeter of a surface
• The volume of a PartBody or a closed surface
• An angle, oriented or not, between two lines, 
directions, or planes
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Using Measure Functions in Formulas (2/3)

2
The list of measures functions appears. Select for 
example the length(Curve,Point,Boolean) item by 
double-clicking on it.

In the Formula Editor panel, select the Measures item 
from the dictionary list.

2
1

1
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Using Measure Functions in Formulas (3/3)

5

The length function is added to the Formula Editor.

You now need to fill the arguments of the function. The 
function description informs you of the nature of the 
arguments. 

For each argument, check that the cursor is positioned 
where the argument is intended to be typed, and then select 
the corresponding feature in the tree. 

Of course, when the argument is an Integer or a Boolean, 
you can just type it. In our example, the third argument is a 
Boolean: type ‘True’ if the length is to be calculated from 
the origin, and ‘False’ if the length is to be calculated from 
the curve end.

Validate by clicking OK.

CATIA may ask you if you want the relation to be updated 
automatically with global update. We advise you to answer 
‘Yes’. 

4

3

4

6

5

3
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Using the Language Browser

The Supported/Inherited 
types field provides you 
with a list of the types 
supported by the selected 
type, and of the types that 
the selected type inherits 
from. 
Double-click on the  type 
to have it automatically 
declared in your relation.

The Attributes field lists 
the possible attributes of 
the selected type, and of 
the supported and 
inherited types.
Double-click on an 
Attribute to have it filled in  
your relation.

The Functions using type 
field lists the functions and 
methods whose first 
argument is a type of the 
Supported/Inherited types 
list. 
The Functions returning type
field lists the functions and 
methods returning the 
selected type.
Double-click on a function to 
have it added to your 
relation.

3

4

5

Select a feature in the tree or in the geometry. Its type is indicated in the 
Type field. You can also choose a type manually using the … button. 

1

2

Open the Language browser panel by clicking on the following Action 
button in a Relation Editor.

6 Click Close to close the 
panel.
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Click on the Equivalent Dimensions icon in the 
common Knowledge Toolbar. The Equivalent 
Dimensions Edition window displays.

Equivalent Dimensions Feature

Select in the list the parameters that will have 
the same value and use the right arrow button to 
add them to the Equivalent Dimension feature. 
Click OK when all the parameters are selected.

Click the Edit List… button. A panel displays for 
you to select the equivalent parameters.

The Equivalent Dimensions feature is displayed 
in the Relations node.
Double-click on it to view the list of parameters, 
modify it or change the value. 

Back in the Equivalent Dimensions Edition 
panel, check the value of the equality before 
validating by clicking OK.

The Equivalent Dimensions feature helps you to define an equality between a set of 
Angle or Length parameters. Its value can be modified through the editor and is 
propagated to all the parameters belonging to the equivalence. 
This feature increases the designer’s productivity and also decreases the model 
size.

2

1

3

4

5

3

2

4
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What is an External Parameter?

These two External 
Parameters are linked to 

their fathers in Wheel_Rim

External Parameters are linked copies of parameters driven 
in an external document.
It is possible to create them provided that the ‘Keep Link 
with selected object’ in the Tools > Option menu is activated.

They can be created:
Automatically by referring to another part’s parameter 
in a relation
Manually by using the Copy/ Paste Special – As Result 
With Link command



Instructor Notes:

Knowledge Advisor

Copyright DASSAULT SYSTEMES 47

����������	
����

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
YS

TE
M

E
S

Why Use External Parameters?

In this example, the hub needs to adapt to the holes of the rims. External parameters have been 
created in order to link the number of holes and the bolt pattern diameter. 

To reuse a parameter that drives a Part into another Part in order to link their 
geometries.
To be sure that the design of the two linked parts is consistent.
To avoid manual update of all the parameters that must have the same value in 
different parts.

Here the Number_of_Bolt_Holes parameter 
has been copied with link from 
Wheel_Rim.CATPart to Wheel_Hub.CATPart.
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Referring to External Parameters in Formulas (1/2)

In a Formula, you can use the parameters defined in the external
documents. 
This is possible between any type of document. 

The following Assembly contains two Parts. 

2

In the specification tree, double-
click on the user parameter 
Axle_Diameter in order to edit it.

1

In the contextual menu of the 
parameter’s value, select the
Edit formula option.
The Formula Editor panel is 
displayed.

1

2
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Provided this option was activated,

an external parameter has been created in 
the Piston_Rod.CATPart
and is used in the newly created formula.

3

Referring to External Parameters in Formulas (2/2)

Select the second instance 
(Piston_Head).
The External parameter 
selection panel is displayed.

4
Select in the tree the user 
parameter Holes_Diameter. 
Validate by clicking OK 
in the External parameter selection, in 
Formula editor, and in the Edit Parameter
dialog box.

5

Remark:
The External parameter selection panel is mainly used to select intrinsic 
parameters. In the case of user parameters, it is possible to directly 
select the parameter in the tree. 
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Creating Lists
You will learn how to create lists. List features can be used to manage lists of objects or 
parameters.



Instructor Notes:

Knowledge Advisor

Copyright DASSAULT SYSTEMES 51

����������	
����

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
YS

TE
M

E
S

What are Lists?

The Knowledgeware List features are lists of ordered features or parameters. 
A list can be populated either automatically or manually. 
The items of a list can be reordered either manually or throughout functions.
The list features are stored under the Parameters node of the specification tree 
and are integrated in the update mechanism.
A ListSize integer parameter indicates the number of items that populate the list. It 
is computed automatically.

Lists can be used:
To make a sum of parameters easily
To count the number of features of a given type in a document and then to 
calculate a cost
To create loops in reactions features or in loops features
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Creating a List

1
In the Knowledge Advisor Workbench, select the List 
icon.
The List Edition panel appears.

The list feature can be manipulated 
through specific functions to:
- Add and remove elements to the list
- Get an element
- Retrieve values from the list
- Move elements of the list to another 
position
- Copy the content of a list into another 
one 

2
Select some parameters or features in the tree and click 
the Add button to add them to the list.

4 The List appears under the Parameters node in the tree, 
and a ListSize parameter is automatically created and 
indicates the number of items in the list.
You can rename the List using its Properties.

3 Validate List creation by clicking OK.
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What is Populating a List Using a Query?

Using the Query function you can automatically populate a List whith features that verify a 
specified expression. 
In the example below, the result of the search will return the holes of the PartBody whose 
diameters are greater than 10mm:

Example: List.1=PartBody.Query("Hole","x.Diameter>10mm")
Where: 

List.1 is the name of the list on which the calculation will be performed
PartBody is the body on which the search will be carried out 
Hole is the Type of the searched feature
x.Diameter>50mm is the expression (optional). If no expression is to be verified, just 
write PartBody.Query("Hole","") 

To know the possible feature types and attributes that you can use in the Query function, 
use the Edit/Search command.
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Populating a List Using a Query

1 Create an empty List: click on the List icon and 
click OK without adding any item to the list.

2 Open the Formula Editor. Select the new List in the 
tree and click the Add Formula button.
The formula editor panel is displayed.

5 The List is automatically populated 
with the holes of diameter greater 
than 5mm.

3
Enter the right side of the formula in the formula 
editor field. For instance: 
PartBody.Query("Hole","x.Diameter>5mm")
In this case, the List will be populated by all the 
holes of diameter greater than 5mm.

4 Click OK to validate the formula creation and close 
Formula panel.
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Associating URLs to Parameters and Relations

You will learn how to create and find URLs attached to parameters and relations.
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Adding URLs

Select the Comment & URLs icon in the Knowledge Advisor 
workbench. 

In the specification tree, select any parameter or relation (formula, 
rule, check, etc) to which the URL will be added. Then click the Add 
button. 
The Add URL dialog box is displayed.

Enter a name for the URL and the link to it. It may be, for instance, 
an Internet address or a path to a document. Click OK to validate 
the creation of the URL.

Back in the main edition window, you can also add a comment to 
the parameter or relation.
Click OK to exit the panel.
The URL and the comment are added to the selected feature.

You can associate one or more URLs with user parameters and relations. This 
task is only meaningful when the active document contains user parameters 
and/or relations. 

1

2

3

4

URLs can also be added to relations 
at their creation or edition. 

To each parameter or relation can be 
added several URLs but only one 
comment.
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Searching for URLs

Click on the Comment &URLs icon.
The URLs & Comment dialog box opens.

From the Edit tab panel:
Select a parameter or a relation in the specification 
tree : the URLs and the comments of the object are 
displayed.

From the Explore tab panel:
Enter the name of the searched URL and click the 
Search button.
If the specified URL is found, “yes” is displayed in 
the Found column. Then return to the Edit Tab.

In the Edit tab, the URL which has been found is 
highlighted.
Click the Go button to display the page or 
document related to this URL.

1

2b

2a

3

OR:

2b

3

2a
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Master Exercise Part 1
Design Process – Part 1 

35 min

Creating User Parameters

Creating formulas between 
the User Parameters and 
the dimensions

1

2

Creating geometry using 
the User Parameters
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Creating Adaptive Behaviors

Creating Rules
Creating Checks
Creating Reactions
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Creating Rules
You will learn how to create and use the Rules feature.
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Adding Sets of Relations

To create sets and sub-sets of relations, click on 
the « Add Set of Relations » icon and select the 
Relations node in which the new set will be created. 
Eventually, rename the Relations sets using their
Properties command (MB3).

While creating a new Relation (Check, Rule, etc), 
select the desired Relation set to store your new 
Relation.

You can create sets of relations below the Relations node of the specification tree. 
Using this capability enables you to regroup the relations into categories.
Formulas, design tables, rules and checks can all be created into relation sets. When 
no relation set has been created, the destination field of the relation editor is by default 
the main Relations node.

1

2
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In the example below, the rule calculates the volume of the PartBody and sets the Material 
parameter in consequence with the result:

What is a Rule?

Here, we have changed the wheel’s size by changing the configuration of the design table: the volume of the wheel 
has changed and its material has been updated automatically.

if smartVolume(PartBody)< Limit_Volume
{Material="Steel"}

if the volume of the PartBody is less 
than a limit value (here 3000cm3), 
the Material is set to Steel

Otherwise, it is set it to 
Chroma

else
Material="Chroma"

A Rule is a set of instructions, generally based on conditional statements, whereby the 
relationship between the parameters is controlled.
A Rule appears in the Relations node of the current document:
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The Rule Editor panel is displayed.
Enter the body of the Rule:
- Check the Alignment button to have an automatic text 
formatting.
- Write your comments between the “/*” and “*/” signs.
- Use the Dictionary to help you select the parameters 
and the functions.

Creating a Rule

Enter the rule name and comments. You can also choose 
the relation set to which the Rule will be added.
Click OK.

Open the Knowledge Advisor workbench and click on the 
Rule icon.

Rule feature is displayed in the tree under the selected 
Relations node/set.

1

2

3

4

5

Check the (!) button to have the syntax of your rule 
verified interactively. 
You can also click the Apply button when you have 
finished scripting the rule to check its syntax.
Click OK to validate the Rule creation.
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Using the Rule/Check/Reaction Editor Interface 

The edition panel of the Knowledge Advisor Reactive Features present a few 
buttons intended to help the user to write the body of the relation.

Check this button to activate the incremental mode: when you select a feature in the specification tree or 
in the geometry area, only the first level of features right below the selected feature will be displayed in 
the editor, which is very useful while working with large models. 

Check this button to have a dynamic verification of the body syntax.

Check this button to have the text automatically formatted and indented.

Click this button to open the Language Browser panel.

In case of syntax errors, click this button to highlight the errors.

Click this button to add a URL to the relation or to change its comment.

Click the Eraser button to clear the contents of the body field.

Type here the feature body.

Use the Dictionary to select the 
parameters and the functions.

Here is a preview of the latest selected 
parameter and of its actual value.
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What is Creating Geometry from Rules?

In order to create more adaptative designs, it is sometimes useful to create 
geometric elements from Rules. To do so, you will use the geometrical operators 
available in the functions dictionary. 
The following geometric elements can be created:

Point 
Plane 
Surface
Line 
Curve
Circle

Case1

Case2
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Creating Geometry from Rules

Once the Rule is created, the geometric element is displayed
in the tree with the F(x) icon meaning that it is driven by a 
formula or a Rule.

Create a new Rule in order to valuate the geometric parameter 
created previously. Use the geometrical operators from the 
Dictionary.

Click on the F(x) icon to open the formula 
editor. 

1

2

3

Select the geometric type of element you want to create (Curve
for example) and click the New parameter of type button. 
Close the formula editor by clicking OK.

The new parametric feature has been added to the tree as a 
geometrical element.
You can rename it by using its properties (MB3).

4

5
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Handling Errors in Rules (1/2)

Intersect curve OK Intersect curve in error => an error
panel is diplayed

It is possible to test a geometric feature in error while creating rules. Indeed, the 
use of geometrical operators to value the geometry in relations may lead to 
update errors in the created features.
For example, if the user values a datum curve with the result of the intersection of 
two surfaces, these two surfaces may not intersect and the intersection curve is 
therefore in error. 
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Handling Errors in Rules (2/2)

In the properties of the Rule (MB3), check the “Do not 
catch evaluation errors” option.

To test if a  feature is in error,  first create a local variable 
using let keyword and use the error keyword as shown in 
the example below:

Now, in case there is no intersection between the 
surfaces, an information panel will be displayed and the 
intersection result will be a line.

1

2

3
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Creating Checks
You will learn how to create and analyze the Checks feature.
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What is a Check?

Check status is OK. Check status is not OK.

Information message

Warning message

There are three types of checks:
Silent – the status of the check is only indicated by the 
feature’s icon.
Information - the status of the check is indicated by the icon, 
and an Information message occurs when the check is wrong.
Warning - the status of the check is indicated by the icon, and 
a Warning message occurs when the check is wrong.

A Check is a set of statements intended to let the user know whether certain conditions are 
fulfilled or not. 
A check does not modify the document. It is applied to and just gives a design indication.
A check usually appears in the Relations node of the specification tree with a traffic light 
icon, switching to red or green according to the check’s status.
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Why Use Checks?

To check that a parameter or a component property responds to a technical limitation or to 
a set of conditions.
To ensure compliance with the corporate design rules. 
To avoid update errors that are foreseeable. The check sends a warning message while 
editing the feature so that the unsuitable value can be changed before an update.

For instance, this check verifies that this mechanical part respects a maximum mass:

The designer edits 
the geometry of 

the part.

The mass of the part 
has grown.
A message informs the 
designer that it does 
not respond anymore 
to the part 
specification.
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Creating Checks

Enter the check name and a comment. You can also 
select the set of relations in which the check will be
placed. Click OK.

In the Knowledge Advisor workbench, click on the 
Check icon.

The Check feature is displayed in the tree under the 
selected Relations node/set.

Type the body of the check in the main field.
A check is a statement generally based on 
comparison operators:

“<”, “<=”, “==”, “>=”, “>”, “<>”.
You can use the Dictionary to help you select the 
parameters.
Click OK to validate the creation of the check.

A check is a relationship between the parameters. A direct feedback on the status of 
the check is given in the tree, thanks to a red or a green light. In case of violation, the 
user can also be informed by a message panel.

1

2

4

3
The Check Editor panel has opened.
Select the type of check in the list and enter a 
message that will appear in case of failure.

5
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Analyzing Checks

The Global Analysis Tool is designed to manage the Knowledge Expert and the 
Knowledge Advisor Checks wherever they may be located in the specification tree. It 
helps to understand the validation status of the designs and allows navigation by 
checks or violations, and highlights failed components. 
In the Knowledge toolbar, the « Check analysis toolbox » icon light indicates the active 
document Checks status:

The Check mode
displays only the 
Check features 
that failed while 
updating the check 
report.

Double-click on an item to display 
the check and the items associated.

Click here to generate 
the customizable report

Click here to display or 
associate a URL

Click here to solve the 
checks created

Click here to launch 
correction (only 
available for the 
Knowledge Expert 
Checks)

Click on the            icon in the toolbar to accede to the Check analysis window:

All the checks are updated and could be fired successfully

All the checks are updated and at least one of them is incorrect

The checks need to be updated

The Failure mode
displays all the 
items that failed 
while updating the 
check report.
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Creating Reactions
You will become familiar with the Reaction feature.



Instructor Notes:

Knowledge Advisor

Copyright DASSAULT SYSTEMES 75

����������	
����
Knowledge Advisor 

Copyright DASSAULT SYSTEMES 75

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
YS

TE
M

E
S

Why Use Reactions? (1/3)

The attached part ‘ForceValue.CATPart’ contains a reaction which forces the 
value of the length.1 parameter to 50mm if it is increased above 50mm. 

The Knowledge Advisor rules have their own limit.

They react to parameter changes or feature updates
� You cannot control exactly when they are fired
� They may be fired several times when you would not like to

They are integrated to the update mechanism
� Parameters cannot be in input and in output. For example, it is not possible to 

write: if x>18mm {x=18mm}

� Loops and conflicts are forbidden

Their language is simple
� And limited too
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Why Use Reactions? (2/3)

To cope with those limitations and to create more associative and reactive designs use 
the Reaction feature.

A reaction is similar to a rule in the fact that:
� It is stored in the model
� It reacts to changes and triggers modifications
� It also references other objects and parameters in the document, and supports 

replace mechanism
� It can be used for the definition of PowerCopies and user defined features

But:
� It can react to a larger amount of changes
� It can drive very complex modifications
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Why Use Reactions? (3/3)

A reaction is a feature that reacts to events on its source(s) by triggering an action

The source can be:
� A selected feature (or a list)
� A parameter (result of a test)

Events can be:
� General events on objects (creation, destruction, update, attribute changes) 

and parameters (value change)
� Specific events such as instantiation and update for a user defined feature

Action can be :
� Written in Knowledge language to access the existing objects in the 

document or in the Visual Basic Script to extend the action scope
� It can access the source object and its arguments
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Creating Reactions

Select the Source type:
- Selection enables you to manually select one or more 
items in the specification tree or in the geometrical area. 
These items will be displayed in the Sources field. 
- Owner enables you to link the action with a feature of 
the geometry or of the specification tree. To link the 
reaction with an object of the geometry, click the 
Destination field and select an object in the specification 
tree or in the geometry. 

In the Knowledge Advisor workbench, click on the 
Reaction icon. The Reaction dialog box opens.

Reaction feature is displayed in the tree:
- Under the Relations node in the Selection mode,
- Under the source in the Owner mode.
You can rename the Reaction using its Properties (MB3).

In the proposed list, select the Event which will trigger 
the Reaction.

Select the language (Knowledgeware or VBScript) in 
which you want to write the action triggered by the 
reaction. Click the Edit Action button.

1

2

4

3

The Action Editor dialog box has opened.
Type the body of the Reaction in the main field.
If you have chosen Knowledgeware language, use the 
Dictionary to select the parameters and the functions.

5

6

Selection mode Owner mode

2

3

4

5

VBScript offers some additional functions and facilities. 
So, in such cases you can use VBScript.
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Creating a Loop in a Reaction (1/3)

Using For statement
The first type of loop is a loop based on the element of a list. See syntax below:

For x inside List
{Body} 

X is a variable name of a given type. It may represent an object or a value. 
List is a variable name of type List or an expression returning a list. 
X (like any other variable of the language) can be used in the body. It contains the 
Nth element of the list. 
The body is executed Nth times, where N is the number of elements of the list.
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Creating a Loop in a Reaction (2/3)

Using For statement
The second type of loop executes until an expression becomes false. See syntax 
below:

For x while predicate
{Body} 

X is a variable name of the integer type. It is incremented at the end of each execution 
of the body. 
Predicate is a Boolean expression. The body is executed as long as this expression 
is true. This expression is evaluated before the body. 

Note that the second for operator can lead to infinite loops.



Instructor Notes:

Knowledge Advisor

Copyright DASSAULT SYSTEMES 81

����������	
����
Knowledge Advisor 

Copyright DASSAULT SYSTEMES 81

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
YS

TE
M

E
S

Creating a Loop in a Reaction (3/3)

Using While statement
This loop executes until an expression becomes false. See syntax below:

let i = 1
let x(Point)

for i while i<=parameter.Size()
{x = parameter.GetItem(i)
if (x.GetAttributeReal("Y") < 0.04)
x.SetAttributeReal("Y",0.04)} 

i is a variable name of the integer type. It is incremented at the end of each execution of 
the body. 
X is a variable for points. 
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Master Exercise Part 2
Design Process – Part 2

15 min

Creating a Rule to control the spacing and 
hole diameter as per the pre-defined designs 
of the brackets, which have to be fixed in 
these holes

4

Creating a Check to 
observe the pattern of the 
holes
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Creating Design Tables and Part Families

Creating Design Tables
Creating a Part Family Catalog
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Creating and Using Design Tables
You will learn how to create Design Tables using the document parameters.
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What is a Design Table?

If you create the design from an existing 
file, it is possible to indicate the sheet 
number where the table is found. 

Design Table icon in the Knowledge Toolbar 

The purpose of the Design Table is to drive the parameters of a CATIA document from 
external values. 
The Design Table allows to create and manage component families. These components 
can, for example, be mechanical parts just differing in their parameter values.
A configuration is a set of parameter value and corresponds to a row.

A Design Table can be created: 
From the CATIA document parameters
From an external file

The values are stored either in a Microsoft ® Excel file on Windows™ or in a tabulated 
text file.
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Why Use Design Tables?

Here is a part whose main 
dimensions are driven by a 
design table.

When you change its configuration, 
three parameters are updated at a 
time, including an intrinsic parameter 
(the access of which is not easy).

To pre-define possible configurations of the model and to ease the modifications of 
the dimensions. 
To select only the realistic configurations of the component.
To link the parameter values that cannot be expressed with a mathematical relation.
To create part families.
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Creating a Design Table from Document Parameters (1/2)

Click on the Design 
Table icon.

Select the parameters to add to the design table and 
use the arrows to add them to the list.
Click OK.

3

2

1

The Design Table creation 
panel is opened. Select 
the option Create a design 
table with current 
parameter values. Click 
OK.

Specify the folder and the file 
name where the data are stored. 
Click the Save button.

4
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Creating a Design Table from Document Parameters (2/2)

The Design Table feature 
appears in the specification 
tree within the Relations node.

6

The Design Table dialog box has 
appeared. The Design Table contains 
only one configuration: the current one. 
If you want to add more configurations, 
click the Edit table button. 
Click OK to confirm the Table creation.

5
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Creating a Design Table with an Existing File (1/2)

Select the Design 
Table icon.1

3

Click yes if you want an automatic association 
between the columns of the external file and the 
parameters of the CATIA document.

You can also create a design table from an already existing file.

4

Specify the external file containing data of your 
design table; Click the Open button.

The Design Table creation panel is open. Select 
the Create a design table from a pre-existing file 
option; Click OK.

2
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Creating a Design Table with an Existing File (2/2)

Automatic association occurs 
between the parameters and the 
columns having exactly the same 
spelling (take care of blank space 
and capital letters).

In the external file, be careful to specify the  
units of the values in the top case of the 
column. If not done, CATIA considers they have 
the international system (meter for length 
etc…).

When using an existing file, you have to manage the associations between the 
columns and the parameters. Here are a few pieces of advice to have them 
automatically made.

If the external file is a text file, take care of having 
only one tab space between the titles and 
between the values.

Same spelling: 
association OK 

A Capital letter has 
been forgotten: 

auto association
not done

2

3

1
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From the Tools->Options...->Parameters and Measure
command, access the Knowledge tab and make sure the 
Interactive Synchronization At Load is checked. 

Click the Create New File... button to generate a file from 
the data contained in the .CATPart document. The Save 
As dialog box displays 

Generating a File From a Design Table

Enter the name of the file that you want to create: .XLS is
the default file type. The text format is also available. 
Click Save and Close when done. The file containing the 
design table data is created. 

If you are working with the option Automatic 
Synchronization At Load, right-click the DesignTable in 
the specification tree and select the DesignTable.x
object->Export content to file... command. 

It is possible to regenerate an external file (.XLS or .txt format) using the data 
contained in the model. The data contained in the model comes from an external 
file that was previously deleted. 
The design Table has to be created with the Duplicate data in the CATIA model 
option.

1

2

4

3

Open the CATPart document of which the Design Table 
file has been deleted or renamed without CATIA. The 
Manage Design Tables window displays indicating that 
the external file has been deleted. 

OR…
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Design Table Functions (1/3)

Various Design Table methods are available to find / set values and configurations in 
the design tables. These functions can be used in Rules and Reactions. The 
explanation for a few functions is given below.

For the design table shown above, an example of the use of ‘CloserSupConfig’ is given below.

Relations\DesignTable1\sheet_name.CloserSupConfig("SketchRadius", 120mm, "PadLim1", 60mm, "PadLim2", 20mm)

The above function will return configuration number ‘3’ (‘third’ configuration).

CloserSupConfig()
This function applies to a design table sheet. It returns the configuration which contains the 
values closest to those given in the arguments. 

When several configurations meet this condition, the method sorts out the possible 
configurations with respect to the column order as it is specified in the argument list.

Syntax of the function is given below:
sheet.CloserSupConfig(columnName: String, minValue: Literal, ...): Integer

40501404

25601203

30501302

10601201

Pad_Limit_2(mm)Pad_Limit_1(mm)SketchRadius(mm)No.
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Design Table Functions (2/3)

CellAsReal()  
This function applies to a design table sheet. It returns the contents of a cell (intended for real 
values). Returns zero if the cell does not contain a real value or if the method arguments are 
not properly specified.

Syntax
sheet.CellAsReal(rowIndex: Integer, columnIndex: Integer): Real

In the above syntax, the rowIndex is the configuration number (integer from 1 to n) and 
columnIndex is the column number.

40501404

25601203

30501302

10601201

Pad_Limit_2(mm)Pad_Limit_1(mm)SketchRadius(mm)No.

Relations\DesignTable1\sheet_name.CellAsReal( 3, 2 )

The above function will return 60.
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Design Table Functions (3/3)

SetCell() 
Enables you to fill in a cell at a given position in an Excel file or a tab file.
Note: the index must start at 1 for the (1,1) cell to be located at the left top corner.

Syntax:
sheet.SetCell(IndexRow:Integer, IndexColumn:Integer, CellValue:Literal): Void
Example:
Sheet.SetCell(2, 2, 45)

501404

601203

451302

601201

Pad_Limit_1(mm)Radius(mm)No.
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Creating a Part Family Catalog
You will learn how to create a Part Family Catalog from a Part containing a Design Table.
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Creating a Part Family Catalog

Create a new CatalogDocument
(File>New). Activate a chapter and click 
on  the Add Part Family icon.

Click the Select Document button to 
browse the CATPart definition 
document. The CATPart must 
contain at least one Design Table 
with a PartNumber column. 
Enter a name for the Family in the 
top field.

In the Browser preview tab, click the 
Select an external preview file  
button to preview an external file in 
the .jpg, .bmp., etc. format (optional).

Edit the Part’s Design Table and insert a column 
called “PartNumber”. Fill in this column with the 
names that will be given to the parts that are 
going to be generated.

1

2

4

3

The part family is created and 
displayed in the specification tree. It 
contains a component per line of the 
design table.
Save the new Catalog document.

5
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Part Family Resolution (1/2)

Resolving a Part Family means that you generate the .CATPart documents referred to 
by the Part Family. 
These documents are generated in a specific place, and each generated document is 
a copy of the generative part configured with the matching row in the design table.

2

1 In Tools>Options indicate the folder where the CATParts associated to the resolved 
components will be generated.

If not already opened, open the catalog containing the Part Family. Activate the Part Family.
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Part Family Resolution (2/2)

4

3 You can resolve either the entire Part Family or a single Part Family component. 
In both cases, use the Resolve option in the contextual menu.

single component resolution

whole family resolution

The resolved component(s) can be identified in the Part Family description.
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Master Exercise Part 3
Design Process – Part 3

15 min

Changing configuration 
and updating the design

Creating a new Design Table from the
existing User Parameters

6
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Using Knowledge Advisor Tools

Using the Knowledge Inspector Tool
Using the Set of Equations Tool
Creating and Using Laws
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Knowledge Inspector Tool
You will learn how to use the Knowledge Inspector tool in order to analyze 
modifications, impacts, and dependencies.
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This mode helps you to understand to what extent changing any parameter of 
your design (such as a dimensional parameter or a material) changes the 
operation or design of the product on which you are working. It can be used to 
examine interactions of parameters with each other, and with the rules that make 
up the product's specifications.

Using Knowledge Inspector: “What if” Mode (Impacts) 

Click on the Knowledge Inspector icon in 
the common knowledge toolbar.

Check the “What If” option. All the 
driving parameters are displayed in the 
top parameters list.
Check the “Show All Parameters” option 
to display all the parameters of the 
document.  
Check the “Geometric Update” if you 
want to visualize the result of your 
modification in the geometry area.

Use the Equals field to modify the 
selected parameter value. 
Click on Apply or Enter to display the 
values of the impacted elements in the 
“Then” area. 

1

2

4

3 Select in the list the parameter whose 
impacts are to be analyzed.
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Using Knowledge Inspector: “How to” Mode (Dependencies)

Click on the Knowledge Inspector 
icon in the Common Knowledge 
toolbar.

Check the “How to” option. The list 
of all the parameters of the 
document that are driven by a 
relation is displayed.
Check “Show all Parameters” to 
have a list of all the parameters of 
the document. The driven 
parameters are identified by an “f”
in the left column.

Click on Apply or Enter.
The list of impacting parameters is 
displayed in the use area.

Helps you to determine how your design can be changed to achieve a desired 
result.

1

2

4

3
Select the parameters whose 
dependencies are to be analyzed.
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Using the Set of Equations tool
You will learn how to use the Set of Equations tool to solve the engineering problems.
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Using the Set of Equations Tool

Click on the « Set of Equations » icon.

Define your set of equations in the editor, 
using the existing parameters.

Use the arrow button to define which 
parameters are Constant parameters or 
Unknown parameters (to be solved).

Click « Apply » to check the syntax.

Click « OK » to exit the 
editor and solve the 
equation system.

Constant parameters can be
modified by using the formula editor.

Select the solve options.

Precision option defines the precision of the 
result.

The Gauss method accelerates the solve
operation while working with the linear
equations.

Maximal computation time enables you to 
indicate the computation time (if 0, the 
computation will last until a solution is found)

The Show ‘Stop’ dialog option displays a 
‘Stop’ dialog box that will enable you to 
interrupt the computation.

1

2

3

4

5

6
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Creating and Using Laws
You will learn how to create and use the Knowledge Advisor Laws and how to combine 
the Knowledge Advisor (KWA) and the Generative Shape Design (GSD) Laws.

Knowledge Advisor Law

Generative Shape Design Law
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Creating a Knowledge Advisor Law

Click on the Law icon. 

Select a destination and give a name to 
the law.

Use the New Parameter of type button to 
create the formal parameters that will be
used to define the law.

Enter the law definition, for example: 
y=cos(5*PI*x*1rad)+10

A Knowledge Advisor law is a relation whereby a parameter is defined with 
respect to another single parameter. Both the parameters involved in a law are 
called formal parameters. The formal parameters and laws are specifically 
designed to be used in the creation of shape design parallel curves.

The Law feature is created under the 
Relations node.

1

2

4

3

5
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Using a Knowledge Advisor Law for Parallel Curves Definition

Click on the Parallel curve icon to create a curve 
parallel to the previous line:

Click the Law button:

The parallel curve is created according to the law
definition:

Create a Line as the reference curve.

Select the reference line
and the support plane.

1

2

3

The Law Definition panel appears, 
select a Knowledge Advisor law in 
the tree and click Close.
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Combining Knowledge Advisor Laws and GSD Laws

Create a GSD law using a reference and a definition curve.

Create a new Knowledge Advisor law. 
Use the GSD law with Evaluate method to define it:

You can use a combination of a Generative Shape Design law and a Knowledge 
Advisor law in the same relation.

1

2
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Knowledge Advisor Added  Exercises

Light Bulb Exercise
Sheet Metal Part Exercise
Wheel Rim Exercise
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Light Bulb
Added Exercise Presentation

1 hour

Embed the knowledge within the design of a light bulb 
assembly using Formulas, Rules and Checks.
Define a light bulb family using a Design Table.
Determine the impacts and dependencies of a parameter 
modification using the Knowledge Inspector tool.
Automate drawing creations using the VBscript Macros 
launched from rules.

In this exercise you will:
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Sheetmetal Part
Sheetmetal Part Exercise: Presentation

25 min

Use a List to automatically get the total number of bends
Use a Rule to compute the part’s cost
Use a Check to control the over cost

In this exercise you will:
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Wheel Rim Exercise

Wheel Rim Exercise Presentation
Wheel Rim Exercise Part 1
Wheel Rim Exercise Part 2
Wheel Rim Exercise Part 3
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Wheel Rim
Exercise Presentation

1hr 25min

Creating Parameters
Creating Formulas
Creating Rules and Checks
Generating a Part Family through design tables
Creating a Reaction

In this exercise, you will automate the design of a 
wheel rim and define a wheel rim family.

You will practice on:
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Wheel Rim Exercise Part 1
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Wheel Rim Exercise Part 2
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Wheel Rim Exercise Part 3


